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Disclaimer 
        

 
     Warning 
     DO NOT USE THIS PRODUCT IN LIFE SUPPORT SYSTEMS. 
 

LIFE SUPPORT POLICY 
ZILOG’S PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL 
COMPONENTS IN LIFE SUPPORT DEVICES OR SYSTEMS WITHOUT THE 
EXPRESS PRIOR WRITTEN APPROVAL OF THE PRESIDENT AND GENERAL 
COUNSEL OF ZILOG CORPORATION. 

As used herein 
 
Life support devices or systems are devices which (a) are intended for surgical implant 
into the body, or (b) support or sustain life and whose failure to perform when properly 
used in accordance with instructions for use provided in the labelling can be 
reasonably expected to result in a significant injury to the user. A critical component is 
any component in a life support device or system whose failure to perform can be 
reasonably expected to cause the failure of the life support device or system or to 
affect its safety or effectiveness. 

Document Disclaimer 

 
©2019 Zilog, Inc. All rights reserved. Information in this publication concerning the 
devices, applications, or technology described is intended to suggest possible uses 
and may be superseded. ZILOG, INC. DOES NOT ASSUME LIABILITY FOR OR 
PROVIDE A REPRESENTATION OF ACCURACY OF THE INFORMATION, 
DEVICES, OR TECHNOLOGY DESCRIBED IN THIS DOCUMENT. ZILOG ALSO 
DOES NOT ASSUME LIABILITY FOR INTELLECTUAL PROPERTY INFRINGEMENT 
RELATED IN ANY MANNER TO USE OF INFORMATION, DEVICES, OR 
TECHNOLOGY DESCRIBED HEREIN OR OTHERWISE. The information contained  
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within this document has been verified according to the general principles of electrical 
and mechanical engineering. 

S3 and Z8 Encore! are trademarks or registered trademarks of Zilog, Inc. All other 
product or service names are the property of their respective owners. 
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Revision History 
Each instance in the Revision History table below reflects a change to this document 
from the previous version. 

Date Rev  Description 

2017 Jul 01  Original Issue 

2018 Nov 02  Added Z8 Encore Family support 

2019 Apr 03 
Added description of new Advanced view for  configuring ZSP password protection and program 
counter (PC) features available in ZSP v2.1 

2020 Sept 04 Converted the chm User Manual file to pdf 
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Overview 
The Zilog Standalone Programmer (ZSP) USB dongle is used for production 
programming or field-updating an application in Flash memory on Zilog’s S3 and Z8 
Encore family of microcontrollers. Target Programming can be performed manually at 
the touch of a button on the ZSP, or automatically by an external programmer through 
the ZSP external controller interface. 

Prior to programming a target device, the USB ZSP dongle must be programmed with a 
target image (Hex) file and configuration information using the ZSP Configuration 
Software running on a Windows PC. This manual explains how to use the ZSP 
Configuration Software. 

The figure below shows the Device configuration information dialog of the ZSP 
software. 
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Getting Started 
This chapter describes the ZSP configuration software prerequisites and how to install 
the ZSP software. For more information on setting up the ZSP USB dongle and 
operating the dongle when the ZSP configuration SW is not running, refer to the Zilog 
Standalone  Programmer User Manual, UM0287. 

Hardware Requirements 

Proper operation of the ZSP configuration software requires the following hardware 
components: 

• Zilog Standalone Programmer (ZSP) USB dongle (ZUSBZSP0100ZACG) 
with a USB mini-B to Type-A cable. 

• PC running a supported operating system with an unused full-speed (or 
higher) USB port that will be used by the ZSP USB dongle 

Supported Operating Systems 

• Windows XP 32-bits (SP3) 
• Windows 7 32 and 64-Bits 
• Windows 8 32 and 64-Bits 
• Windows 10 32 and 64-Bits 

  
Installing the ZSP Configuration Software 

1. Download ZSP from the Downloadable Software category > Free software in the 
Zilog Store  

2. Run the software installation file and follow the on-screen instructions to install 
the ZSP configuration software and ZSP Windows driver package. 

3. Attach the ZSP USB dongle to the PC where the ZSP configuration software was 
installed 

http://www.zilog.com/index.php?option=com_zcm&task=sdlp&Itemid=74�
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Using the ZSP Configuration Software 
This section describes the ZSP configuration software menu bar, toolbar icons and 
windows. The menu bar is described from left to right (Project, View, Operations, and 
Help). Drop-down menu options and their associated dialog boxes are described from 
top to bottom. Toolbar icons are a one-click shortcut to the most commonly used 
submenu options. For example the Open Project toolbar icon is a one-click shortcut to 
the Open drop-down menu option available by clicking Project on the menu bar. 
 
The ZSP configuration software display is composed of three windows: Settings, Output 
and Configuration. The layout of the Settings and Output windows does not change, but 
the information displayed and user controls available in the Configuration window 
changes depending on which project view is active. 
 
Refer to the Tutorial section to learn how to accomplish common tasks using the ZSP 
configuration software. 
 

• Menu Bar 
• Toolbar Icons 
• Windows  
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Menu Bar 

The menu bar activates one of the ZSP configuration software top-level menus. Each 
top-level menu consists of a drop-down list of 

related options. Menu options that end with an ellipsis (...) open a dialog box requiring 
user input. The following drop-down menus are available through the menu bar:  

• Project menu 
• View menu 
• Operations menu 
• Help menu 

 

Project Menu 

   

The ZSP Configuration software uses project files to store target configuration 
information such as processor type and the location the Hex file containing the actual 
application image to be programmed into the target in standalone mode of operation. 
The Project menu is used to perform project file operations such as opening and closing 
existing project files, creating a new project file or saving project file changes. The 
following menu items are available in the Project drop-down menu: 
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• New Create a new project   

• Open Open an existing project   

• Close Close the current project   

• Save Save the current project   

• Save As Save the current project with a new name   

• Recent 
  

Display recently opened projects and open an existing project   

• Exit Close the ZSP Configuration Software environment   

 

View Menu 

   

The View menu selects which group of settings (Device, Image File, Serialization, and 
Communication) is displayed in the ZSP Configuration window.  Click the name of the 
configuration view for a description the settings that can be modified. 

• Device 
• Image FIle (.hex) 
• Serialization 
• Communication 
• Advanced 
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View > Device menu 

The device view shows configuration settings pertaining to the target MCU that will be 
programmed in standalone mode. Selections made in the device configuration window 
allow the ZSP configuration software to properly initialize the USB programmer. For 
proper target programming and operation, it is important that the application was built 
using compatible device settings. 

1. Launch the ZSP Configuration Software 
2. Click View on the menu bar and then click Device to display the Device 

configuration . 
3. Click on the Product Family drop-down list box to select the Product Family. 
4. Select the Series from the drop-down list. 
5. Select the Device from the drop-down list. Click the DeviceInfo button for a brief 

description of the Device selected. 

For S3 devices:  

6. Click the Enable Read Protection checkbox to enable read protection. Once 
enabled, it will no longer be possible for the ZSP to read the contents of Flash 
memory on the S3 target (all data read from the target will have a value of 0x00, 
even if the target was programmed). Consequently, when the ZSP is used to 
verify the contents of S3 target Flash memory, the operation will fail, the red FAIL 
LED is illuminated, and an error code will be displayed on the LCD panel.  

7. Click the Enable Hard Lock Protection checkbox to enable hard lock protection. 
Once enabled, it will not be possible for an application programmed into Flash 
memory on the S3 target to erase and/ or reprogram the contents of Flash 
memory. Hard Lock protection does not affect the ability of the ZSP to verify the 
contents of S3 target Flash memory.: 
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Device Info Button  

Clicking the DeviceInfo button displays information about the target MCU as shown in 

the following example: 
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If you do not have the ZDS II-S3 or Z8Encore! documentation installed on your 

machine, perform the following procedure below: 

Download and Install the S3 Documentation  

1. Download ZDS II - S3 5.3.2 (or later) from the Zilog Software Downloads page. 
2. When the download is complete, unzip the file to your hard drive, then double-

click the installation file named DOCS_S3_<Version>.exe and follow the on-
screen instructions. 

Download and Install the Z8Encore Documentation  

1. Download ZDS II - Z8 Encore! 5.2.2(or later) from the Zilog Software Downloads 
page. 

2. When the download is complete, unzip the file to your hard drive, then double-
click the installation file named DOCS_Z8Encore!_<Version>.exe and follow the 
on-screen instructions. 

 

 
 

https://www.zilog.com/index.php?option=com_zcm&task=sdlp&Itemid=74�
https://www.zilog.com/index.php?option=com_zcm&task=sdlp&Itemid=74�
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View > Image File (.hex) menu 
The Image File configuration window is used to select the Hex file to be programmed 
into Flash memory on target devices when the ZSP EXE button is pressed with the 
selection switch in the Program position. 

1. Launch the ZSP Configuration Software 
2. Click View on the menu bar and then click Image File (.hex) to open the Image 

File configuration window.. 
3. Click the Browse button ( ) to open the Open dialog box. 
4. Navigate to the folder containing the appropriate Hex file and then double click 

the filename. Alternatively click the appropriate filename and then click the 
Open button.  
 

Checksum 

1. Click the Checksum button to open the Calculate Checksum dialog box. 
2. Click the Start button to view the checksum values. 
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View > Serialization menu  
The Serialization view is used to enable or disable programming a unique serial number 
into Flash memory on the target device when the ZSP EXE button is pressed with the 
selection switch in the Program position. The serial is incremented or decremented after 
each target is programmed based on the settings in the serialization view.  

1. Launch the ZSP Configuration Software 
2. Click View on the menu bar and then click Serialization to display the 

Serialization configuration window. 
3. Click the Enable Serialization checkbox to enable programming a unique serial 

number into Flash memory on the target device. When serialization is enabled 
(Enable Serialization checkbox is displayed with a checkmark) additional 
serialization controls will be enabled as explained below. Clicking the Enable 
Serialization checkbox when the checkbox is checked disables serialization and 
all controls except the Enable Serialization checkbox. 

4. In the Serial Address text box, enter the target memory location where the first 
byte of the serial number is to be programmed. Subsequent bytes in the serial 
number are programmed into sequential address after the starting address. For 
proper programming and operation of the target device, the Serial Address must 
be located within the Flash address space of the target and must not overlap any 
areas of Flash memory occupied by the target image (Hex) file. 

5. Enter the length of the serial number (in bytes) in the Serial Number Size text 
box; or click the dropdown arrow to select the length of the serial number. Serial 
numbers must be between 1 and 8 bytes long. 

6. Enter the decimal value to add to the serial number after each target device is 
programmed in the Increment/Decrement(+/-) text box.  Entering a positive 
value causes the serial number programmed into subsequent target devices to 
increase while entering a negative value causes subsequent serial numbers to 
decrease. Entering a value of 0 results in all target devices being programmed 
with an identical serial number. 

7. Enter the value of the serial number to be programmed into the Serial Number 
textbox. After the first target device is programmed, the serial number the ZSP 
uses to program the next target device is incremented (or decremented) by the 
value in the  Increment/Decrement(+/-) text box. The initial serial number can be 
entered in hexadecimal or decimal by clicking either the  Hex or  Dec radio 
buttons. Clicking the Hex and  Dec radio buttons after the serial number has 
been entered causes the starting serial number to be displayed according to 
which radio button is last selected. 
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8. After completely configuring the Serialization settings (as well as the Device and 
Image File settings) click the Download CFG toolbar icon to load the Serialization 
settings into the ZSP for subsequent device programming operations. Note that 
when a serialized target is verified, the target’s serial number is ignored. Also , 
note that the Serial Number value displayed after clicking the Upload CFG 
toolbar icon might not match the Downloaded configuration if the ZSP was used 
to program one or more target devices. 
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View > Communication menu 
The communication view is used to select which ZSP device is to be configured by the 
ZSP configuration software and optionally clear all ZSP configuration information or 
upgrade the ZSP firmware. Launch the ZSP Configuration Software.  

1. Click the View menu bar item and then click Communication to display the ZSP 
communications settings. 

2. Select the serial number of the ZSP device to be configured by clicking in the 
ZSP Serial Number list box (or clicking the drop-down arrow) and then click the 
appropriate entry. If there is only one ZSP device attached to the PC, then only 
one serial number is displayed. If the serial number of the ZSP device to be 
configured is not displayed in the drop-down list, then click the Refresh button (

). 

 
 

Clear ZSP Configuration and Image area Start Button 

Click the Clear ZSP Configuration and Image area Start button ( ) to clear all target 
configuration information (including the target image file). It can take up to approx. 60 
seconds to completely clear all configuration information and image file(s) from the ZSP.  
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During this time, the Windows mouse pointer will change to the busy icon and the ZSP 
configuration software title bar may show “Not Responding”. Once all ZSP configuration 
information has been cleared, the Output window will display a message indicating 
whether the operation succeeds, and the mouse pointer icon returns to normal. If the 
“NOT Responding” message was displayed in the application title bar, that message is 
removed once all configuration data has been cleared. 
 
Typically there is no need to clear the target configuration information using the Clear 
ZSP Configuration and Image area Start button. However, if the red FAIL LED is 
illuminated and error code -127 is displayed on the LCD panel, then it may be 
necessary to clear all target configuration information before new configuration 
information can be downloaded into the ZSP. Typically, this only becomes necessary if 
power is lost while downloading new configuration information to the ZSP. 

 

 
 

Upgrade Firmware Start Button 

1. Click the Upgrade Firmware Start button to open the Firmware Upgrade dialog 
box as shown below:  
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2. In the Upgrade Options area, select whether ZSP firmware and/or Boot Loader 
module should be upgraded or verified by clicking the associated checkbox. By 
default, both the ZSP firmware and Boot loader checkboxes are selected 
(checked) indicating that both modules will be upgraded or verified. 

3. Click the Upgrade button to update the selected firmware module(s). Status 
messages are displayed in the Status window in the lower portion of the 
Firmware Upgrade dialog box during the upgrade or verify operation. Messages 
displayed during a successful ZSP FW upgrade will be similar to the messages 
shown in the following figure: 
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The ZSP Configuration and Image Area must be erased prior to upgrading the 
firmware if the configuration information format of the new firmware is not 
compatible with the configuration information format used by the current ZSP 
firmware. In this instance, after clicking the Upgrade button, the user will be 
prompted to confirm whether the ZSP Configuration and Image Area can be 
erased before proceeding with the firmware, as shown below 
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4. Click the Verify F/W button to verify whether the ZSP firmware and/ or Boot 
Loader firmware modules are the latest version. Messages displayed during 
a successful verification of the ZSP firmware will be similar to the messages 
shown in the following figure: 

  

5. Click the Close button to exit the Firmware Upgrade dialog box. 
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View > Advanced  
The advanced view is used to enable password protection of select ZSP operations and 
to optionally limit the number of target devices that can be programmed through the use 
of a Program Counter (PC). 

Password Protection 

When password protection is enabled, the following ZSP operations will be blocked 
(ZSP in a Locked state) until the user enters the correct password (ZSP in an Unlocked 
state): 

• Download configuration 
• Upload configuration 
• Change the current ZSP password 
• Disable password-protection 
• Enable program counter 
• Modify current value of the program counter 
• Disable program counter 

 

Please Note: Once the user enters the correct password to unlock a password-
protected ZSP, the ZSP remains in an unlocked state until it is reset (typically 
accomplished by disconnecting and then reconnecting the ZSP USB cable). While the 
ZSP is unlocked, users who don't know the current ZSP password can reconfigure the 
ZSP to use a different image file, program counter, or disable password protection. 
Users are cautioned against leaving an unlocked ZSP unattended for long periods of 
time to prevent misconfiguration. 

ZSP password protection does not cause the ZSP to encrypt the target image file or 
encrypt data sent over USB. Password protection only prevents users who do not know 
the current ZSP password from being able to perform the ZSP operations listed above. 
A password protected ZSP (even in the locked state) can be used to verify, erase, and 
program target devices. However, programming operations will fail if the program 
counter is enabled and has reached zero. 

The configuration window of the Advanced view indicates whether ZSP password 
protection is enabled or disabled and, if enabled, whether the ZSP is in a Locked state  
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(user must enter correct password before password-protected operations can be 
performed) or an Unlocked state (password-protected operations may be performed). 

When password protection is disabled the Password Protection checkbox is 

unchecked  and when password protection is enabled the Password 

Protection checkbox is checked . The 'lock state' of a password 
protected ZSP is displayed in the ZSP Protection Status area of the Advanced view's 
configuration window. The lock state of a password protected ZSP will either be locked  

or unlocked . 

When the ZSP Configuration and Image Area is cleared (see Communication view) 
password protection is disabled. This is the factory default state of the ZSP. If the user 
forgets the current ZSP password, clearing the Configuration and Image area will return 
the ZSP to the factory default state disabling password protection (and the program 
counter). 

For more information about ZSP password protection, click one of the following links: 

• How to enable ZSP password protection 
• How to unlock password protected ZSP operations 
• How to change the current ZSP password 
• How to disable ZSP password protection 

Program Counter (PC) 

Once a password protected ZSP is in an unlocked state, the Program Counter (PC) can 
optionally be enabled to limit the number of target devices that can be programmed by 
the ZSP. When the PC is enabled, the configuration window in the advanced view 
displays two PC value as shown below: 
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The PC to ZSP value represents the 'new' PC value that will be stored in the ZSP 
Configuration and Image Area once the Apply button is clicked. The PC to ZSP ZSP 
value must be between 0 and 4294967296. The PC from ZSP value represents the 
maximum number of devices that can still be programmed with the current image file. 
Every time a target device is successfully programmed, the PC from ZSP value 
decrements. Once the PC from ZSP value reaches 0, it will no longer be possible for 
the ZSP to be program any more target devices until one of the following events occurs: 

The PC to ZSP value is changed to a non-zero value and the Apply button is 
clicked 
The program counter is disabled 
ZSP password protection is disabled 
ZSP Configuration and Image area is cleared 

If the user presses the EXE button to Program a target while the PC from ZSP is 
enabled and has a value of 0, then the ZSP LCD will display -21 indicating that the 
maximum number of programming operations has been reached and the buzzer will 
sound the fail tone. 

For more information about the ZSP program counter, click one of the following links: 

• How to enable the ZSP program counter 
• How to change the current program counter value  
• How to disable the ZSP program counter 
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Operations Menu 
The Operations menu provides access to the two main functions of the ZSP 
configuration software: Downloading and Uploading target configuration information 
(including application image file) as shown in the figure below. Note that the Operations 
menu options are inactive (greyed out) until a project is opened (or created) that 
contains valid device configuration settings and an image file. The operations menu 
options will fail to operate as expected unless the Zilog Standalone Programmer USB 
dongle is attached to the PC running the ZSP configuration software 

 
 

Click the Download Configuration menu option to download configuration settings 
entered into the View > Device and View > Serialization dialog boxes into the ZSP as 
well as the application image file referenced from the View > Image File dialog. 
 
Click the Upload Configuration menu option to see the configuration settings currently 
used by the ZSP programmer.  
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Download Configuration 

 

Click the Download CFG toolbar icon (or Operations on the menu bar, and then click 
Download Configuration) to download configuration settings and the application 
image (Hex) file into the ZSP for subsequent programming of target devices. Status 
messages are displayed in the Output window as configuration information is 
downloaded into the ZSP.  

A sample of the output is shown below. 

 

Upload Configuration 

   

Click the Upload CFG toolbar icon (or Operations on the menu bar, and then click 
Upload Configuration) to view ZSP configuration settings and, optionally, upload a 
copy of the application image file to the PC file system. The following figure shows an 
example of the configuration information uploaded from the ZSP (in the Uploaded 
Configuration column) and the current ZSP project file configuration (in the Current 
Configuration column): 

  

 



 

UM029304-0920 

 

 

 

 

Differences between the configuration information read from the ZSP versus the configuration information contained 
within the current ZSP project are highlighted in red as shown below: 
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• To upload a copy of the target image file from the ZSP and save it in the PC file 
system, use the following procedure:  

1. Click the browse (...) button next to the Upload Image near the bottom of the 
Upload Configuration dialog box. This causes the Open dialog box to appear.  

2. Navigate to the PC folder where the uploaded image file is to be stored and then 
enter the name of the file to be created that will contain the uploaded image file in 
the File name: text box. Alternatively, if an existing file is to be overwritten using 
the upload image, just click the name of the file displayed in the Open dialog box 

3. Once the appropriate file name has been entered or selected, click the Open 
button to return to the Upload Configuration dialog box. 

4. Click the Upload Image button to upload the application image and store it in the 
PC file system using the specified file name 

• Click the Refresh button to upload the ZSP configuration information again. 
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• Select Update the Current with the Uploaded Configuration on Close to update 
the current project. Please note that the unused or don't care bits for the Smart 
Options are updated to the erased value of "1" and may not match the Uploaded 
Configuration after Close. 

• Click the Close button or the "X" icon in the upper right corner of the dialog box to 
exit from the Upload Configuration dialog box again. 
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Help Menu 

 
 

The help menu is used to display information about the operation of the ZSP 
configuration software, the version of the ZSP configuration SW and how to contact 
technical support to resolve issues with the operation of the ZSP software or USB 
programmer. 

• Help Topics ... - Opens this online help/user manual 

• Technical Support - Displays the Zilog Technical Support page in the default 
web browser. 

• About ... - Displays the current ZSP Configuration Software version number. 
 

              

Toolbars 

 

Toolbar icons are a one-click shortcut to the most commonly used drop-down menu 
options available through the menu bar.  Click the name of one of the toolbar icons for 
more information. 
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• Open Project 
• Close Project 
• New Project 
• Save Project 
• Download CFG 
• Upload CFG 

Toolbars > Open Project 

 

Click the Open Project toolbar icon (or Project on the menu bar, and then click Open) 
to open the Select a Project Name dialog box as shown below: 

                

To open an existing project, navigate to the folder containing the ZSP project file (with 
an extension of zspproj) of interest and double-click the name of the file. Alternatively, 
single click the project filename and then click the Select button. 
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Toolbars > Close Project 

 

Click the Close project toolbar icon (or Project on the menu bar, and then click Close) 
to close the current ZSP project. This disables the Close Project, Save Project, 
Download CFG, and Upload CFG toolbar icons (icons greyed out). Similarly the Close, 
Save, and Save As options in the Project drop-down menu are disabled. 

Toolbars > New Project 

 

1. Click the New Project toolbar icon (or Project on the menu bar, and then click New) 
to create a new ZSP project file. This causes the New Project dialog box to open as 
shown below:  

                    

2. Click the Browse button ( ) to open the Select a Project Name dialog box.  
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3. Navigate to the directory folder where the project file is to be saved by clicking the 
Look In drop-down list, double-clicking folder names, or clicking the Previous, Up, 
and Create Folder icons. 

4. In the File name: text box, type the name of the project file to be created. Then click 
the Select button or press the <Enter> key. This causes the Select a Project Name 
dialog box to close and the full path and filename of the project file to be created will 
be displayed in the New Project dialog. In the sample screen shot below, a project 
named “tutorial” is being created in the default ZSP sample folder <ZDS Installation 
Drirectory>\sample. 
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Do not specify an extension when typing the name of the ZSP project file to be 
created. The ZSP configuration software will automatically append the correct 
extension (zspproj) when the project file is actually created if (and only if) the user 
does not specify an extension. However, if the user specifies a non-default extension 
when creating the project, then by default the ZSP configuration software will not 
show the name of the project in the Open Project dialog box making it difficult to 
locate the project in the future.  

5. Once the project file name and location are correct, click OK to exit the New Project 
dialog box. This causes the ZSP Configuration Software to create an empty ZSP 
project file. The ZSP Output window will display progress messages as the new 
project file is created and saved as shown below:  

 

Toolbars > Save Project 

                  

Click the Save Project toolbar icon (or Project on the menu bar, and then click Save) 
to save any changes made to the current ZSP project. The project will remain open in 
the ZSP Configuration Software after changes have been saved allowing the user to 
make additional modifications and/or upload/download configuration information. 
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Toolbars > Download CFG 

                  

Click the Download CFG toolbar icon (or Operations on the menu bar, and then click 
Download Configuration) to download configuration settings and the application 
image (Hex) file into the ZSP for subsequent programming of target devices. Status 
messages are displayed in the Output window as configuration information is 
downloaded into the ZSP. 

A sample of the output is shown below. 
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Toolbars > Upload CFG 

             

Click the Upload CFG toolbar icon (or Operations  on the menu bar, and then click 
Upload Configuration) to view ZSP configuration settings and, optionally, upload a 
copy of the application image file to the PC file system. The following figure shows an 
example of the configuration information uploaded from the ZSP (in the Uploaded 
Configuration column) and the current ZSP project file configuration (in the Current 
Configuration column): 
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Differences between the configuration information read from the ZSP versus the 
configuration information contained within the current ZSP project are highlighted in red 
as shown below: 

 

• To upload a copy of the target image file from the ZSP and save it in the PC file 
system, use the following procedure: 

1. Click the browse (...) button next to the Upload Image near the bottom of the 
Upload Configuration dialog box. This causes the Open dialog box to appear.  

2. Navigate to the PC folder where the uploaded image file is to be stored and then 
enter the name of the file to be created that will contain the uploaded image file in 
the File name: text box. Alternatively, if an existing file is to be overwritten using 
the upload image, just click the name of the file displayed in the Open dialog box 

 



 

UM029304-0920 

 

 

 

3. Once the appropriate file name has been entered or selected, click the Open 
button to return to the Upload Configuration dialog box. 

4. Click the Upload Image button to upload the application image and store it in the 
PC file system using the specified file name 
 

• Click the Refresh button to upload the ZSP configuration information again. 
• Select Update the Current with the Uploaded Configuration on Close to update the 

current project. Please note that the unused or don't care bits for the Smart 
Options are updated to the erased value of "1" and may not match the 
Uploaded Configuration after Close. 

•  Click the Close button or the "X" icon in the upper right corner of the dialog box to 
exit from the Upload Configuration dialog box again. 

Windows  

This section describes the function of the three windows that comprise the ZSP 
configuration software display.  Click the name of a window to see more information. 

• Settings window 
• Configuration window 
• Output window 
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Settings window  
The settings window lists the set of all configuration panels (views) that can be activated 
in the configuration window. Each configuration panel contains settings that can be 
viewed and/or modified to control the operation of the Zilog Standalone Programmer 
when erasing, programming, and verifying the contents of Flash memory on target 
devices. 
 
To activate a particular view, click the corresponding view name listed under the 
Settings accordion when it is in the expanded state as shown below. For example, 
clicking the Device view will open the Device configuration panel in the configuration 
window on the right side of the ZSP configuration software display.  
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If the Settings accordion is collapsed (shown below), then click the + sign to the left of 
Settings to expand the list of configuration panels and then click the view of interest. To 
collapse the settings accordion, click the – sign to the left of Settings when it is in the 
expanded state. 

 

 
The configuration panels available through the Settings window can also be activated 
by clicking View on the menu bar and then clicking the configuration panel view of 
interest.  
   
For more information about a particular configuration panel view, click one of the 
following links: 

• Device 

• Serialization 

• Image File (.hex) 

• Communication 

• Advanced 
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Configuration window  
The ZSP configuration settings that can be modified by the user are displayed in the 
Configuration window. The layout of the configuration window changes based upon 
which project view (i.e. configuration panel) is currently active. To change views, click 
View on the menu bar and then select one of the views listed in the drop-down menu. 
Alternatively, click on one of the configuration panel views listed under the Settings 
accordion on the Settings Window. 
 
The figure below shows some of the configuration settings available when the Device 
view is active. The settings displayed in the Configuration window will change when the 
Image File, Serialization, or Communication views become active. 
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Output window  
The output window displays information messages as the ZSP configuration software 
processes user inputs as shown below: 
 
 

 
 

Use the slider on the right side of the output window to display older (at the top of the 
output window) or newer messages (at the bottom of the output window). To clear all 
messages displayed in the output window, right-click anywhere in the output window 
and click the Clear pop-up menu option. 

Tutorial  
This tutorial shows you how to use the basic features of Zilog Standalone Programmer 
Configuration Software. 

In this tour, you will do the following 

• Create a New Project 

• Configure Project for Downloading 

• Uploading Project Configuration 

• Saving the Project 

When you complete the tutorial, you will be able to program your target MCU in 
standalone operation. 
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   Create a New Project 

1. Click the New Project toolbar icon (or Project on the menu bar, and then click New) 
to create a new ZSP project file. This causes the New Project dialog box to open as 
shown below: 

 

  

2. Click the Browse button ( ) to open the Select a Project Name dialog box. 
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3. Navigate to the directory folder where the project file is to be saved by clicking the 
Look In drop-down list, double-clicking folder names, or clicking the Previous, Up, 
and Create Folder icons. 

4. In the File name: text box, type the name of the project file to be created. Then click 
the Select button or press the <Enter> key. This causes the Select a Project Name 
dialog box to close and the full path and filename of the project file to be created will 
be displayed in the New Project dialog. In the sample screen shot below, a project 
named “tutorial” is being created in the default ZSP sample folder <ZDS Installation 
Directory>\sample. 

 
  

Do not specify an extension when typing the name of the ZSP project file to be 
created. The ZSP configuration software will automatically append the correct 
extension (zspproj) when the project file is actually created if (and only if) the user 
does not specify an extension. However, if the user specifies a non-default 
extension when creating the project, then by default the ZSP configuration 
software will not show the name of the project in the Open Project dialog box 
making it difficult to locate the project in the future.  

5. Once the project file name and location are correct, click OK to exit the New Project 
dialog box. This causes the ZSP Configuration Software to create an empty ZSP 
project file. The ZSP Output window will display progress messages as the new 
project file is created and saved as shown below: 
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Configure Project for Downloading 
 
1. From the ZSP Configuration Software environment, select Settings > Device from 

the Settings window. 
2. Click on the Product Family drop-down list box to select the Product Family. 
3. Select the Series from the drop-down list. 
4. Select the Devices from the drop-down list. Click on the DeviceInfo button for a brief 

description of the Device selected. 
5. Select the Flash Options in the Flash Options window. See an example Device 

Settings below: 
 

  
 

6. Select Settings > Serialization from the Settings window. 
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7. Click Enable Serialization if desired. Deselect if not. 
8. If Enabled, enter the Serial Address where it will be written. This location must be 

written to a location that is not written to by the hex file. 
9. Enter the Serial Number Size. This is the number of HEX bytes that the Serial 

Number will occupy. 
10. Type the decimal interval that you want the serial number incremented by in the 

Increment Dec (+/-) field. If you want the serial number to be decremented, type in a 
negative number. After the current serial number is programmed, the serial number 
is then incremented or decremented by the amount in the Increment Dec (+/-) field. 

11. Type the start value for the serial number in the Serial Number field and select the 
Hex button for a hexadecimal serial number or Dec button for a decimal serial 
number. 
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12. Select Image File(hex) from the Settings window. 
13. From the File Name dialog box, click on the Browse button ( ) to navigate to 

the directory where the file is located. 
14. Select the hex file (in this tutorial, select the demo.hex) and click on the Open 

button. 

  

 Note: You can click on the Checksum button on the right to display the 
checksum values. 

15. Select Communication from the Settings window to configure the ZSP connection 
to the host PC. 

16. Select the ZSP USB Serial Number from the drop-down list. Click on Refresh 
button if you do not see the ZSP connected to your host PC. 
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17. Configuration is done and is now ready for downloading to the ZSP. 
 Selecting Operations and then Download Configuration will connect and download 

the configuration to the Zilog Standalone Programmer. Alternatively you can click 
on the Download CFG toolbar icon to perform the same operation. A successful 
Download  

18. Configuration operation will show the following message to the Output window:  
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Uploading the Configuration 

 
Click the Upload CFG toolbar icon (or Operations  on the menu bar, and then click 
Upload Configuration) to view ZSP configuration settings and, optionally, upload a 
copy of the application image file to the PC file system. The following figure shows an 
example of the configuration information uploaded from the ZSP (in the Uploaded 
Configuration column) and the current ZSP project file configuration (in the Current 
Configuration column): 

 

        

 
Differences between the configuration information read from the ZSP versus  
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the configuration information contained within the current ZSP project are highlighted in 
red as shown below: 

 

• To upload a copy of the target image file from the ZSP and save it in the PC file 
system, use the following procedure: 

1. Click the browse (...) button next to the Upload Image near the bottom of the 
Upload Configuration dialog box. This causes the Open dialog box to appear.  

2. Navigate to the PC folder where the uploaded image file is to be stored and then 
enter the name of the file to be created that will contain the uploaded image file in 
the File name: text box. Alternatively, if an existing file is to be overwritten using 
the upload image, just click the name of the file displayed in the Open dialog box 

3. Once the appropriate file name has been entered or selected, click the Open 
button to return to the Upload Configuration dialog box. 

4. Click the Upload Image button to upload the application image and store it in the 
PC file system using the specified file name 
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• Click the Refresh button to upload the ZSP configuration information again. 
• Select Update the Current with the Uploaded Configuration on Close to update 

the current project. Please note that the unused or don't care bits for the Smart 
Options are updated to the erased value of "1" and may not match the Uploaded 
Configuration after Close.  

• Click the Close button or the "X" icon in the upper right corner of the dialog box to 
exit from the Upload Configuration dialog box again. 

Saving the Project 

               

Click the Save Project toolbar icon (or Project on the menu bar, and then click Save) 
to save any changes made to the current ZSP project. The project will remain open in 
the ZSP Configuration Software after changes have been saved allowing the user to 
make additional modifications and/or upload/download configuration information. 
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How to Enable ZSP Password Protection 
When ZSP password protection is disabled, the Password Protection check-box 
displayed in the configuration window of the Advanced view will be unchecked (blue 
circle) and the ZSP Protection Status will be marked disabled (red circle): 

 

To enable password protection, click the Password Protection check-box. This 
causes the Enter Password text-box to open where the user can set the ZSP 
password. ZSP passwords must be between 1 and 16 characters long. Any 
combination of letters, numbers, and symbols may be used. ZSP passwords are case 
sensitive. Note that while the user is specifying the initial ZSP password the ZSP 
Protection Status: remains in the Disabled state. after entering the password click 
OK to store the password within ZSP non-volatile memory. 
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After the ZSP password has been configured, the Password Protection check-box is 
displayed in the checked (active) state and ZSP Protection Status: is now Enabled, 
Unlocked. In addition a Change Password check-box is displayed and the user may 
optionally enable the program counter. 

 

 

How to Unlock a Password Protected ZSP 
Password-protected operations initiated while the ZSP is in a locked state (password 
protection enabled and the ZSP password has not been entered since the last time the 
ZSP was reset) cause an error message to be displayed in the output window indicating 
that a password is required to unlock the protected ZSP operation.  

 

Password-protected operations initiated while the ZSP is in a locked state (password 
protection enabled and the ZSP password has not been entered since the last time the 
ZSP was reset) cause an error message to be displayed in the output window indicating 
that a password is required to unlock the protected ZSP operation.  

 

 

To unlock the ZSP, click the Enter Password button which opens the Enter Password 
window. 



 

UM029304-0920 

 

 

 

                     

After typing the ZSP password click the OK button, or press the Enter key. If the 
password does not match the password entered when password protection was 
enabled (see How to Enable ZSP Password Protection) or when the password was last 
changed (see How to Change the ZSP Password) then error code -21 (ZSP locked) is 
displayed on the ZSP LCD and the buzzer sounds the fail tone. In this instance, it is 
necessary to re-enter the ZSP password and click the OK button (or press the Enter 
key) again. 

After the correct ZSP password has been entered, the Password Protection check-box 
will be in the checked (active) state and ZSP Protection Status: will be Enabled, 
Unlocked. 

 

How to Change the ZSP Password 
The current ZSP password can only be changed when the ZSP is in an Unlocked state 
(correct ZSP password typed into the Enter Password textbox since the last time a 
password-protected ZSP was reset). If the ZSP is unlocked, then the configuration 
window of the Advanced view indicates that Password Protection is enabled (blue 
circle) and that the ZSP is in an unlocked state (red circle). 
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If the ZSP Protection Status is shown in an Enabled, Locked state, then it will first be 
necessary to unlock the ZSP as described in the How to Unlock a Password Protected 
ZSP before it will be possible to change the ZSP password. 

To change the current ZSP password, click the Change Password button which opens 
the Enter Password window. 

 

After typing the new ZSP password click the OK button, or press the Enter key to store 
the password in ZSP non-volatile memory. The next time the ZSP is power-cycled 
(typically accomplished by disconnected and the reconnecting the ZSP USB cable), use 
the new ZSP password to enable password-protected operations.  

How to Disable ZSP Password Protection 
ZSP password protection can only be disabled when the ZSP is in an Unlocked state 
(correct ZSP password typed into the Enter Password textbox since the last time a 
password-protected ZSP was reset). If the ZSP is unlocked, then the configuration 
window of the Advanced view indicates that Password Protection is enabled (blue 
circle) and that the ZSP is in an unlocked state (red circle). 

 

If the ZSP Protection Status is shown in an Enabled, Locked state, then it will first be 
necessary to unlock the ZSP as described in the How to Unlock a Password Protected 
ZSP before it will be possible to disable ZSP password protection. 

 



 

UM029304-0920 

 

 

 

There are two methods of disabling ZSP password protection. The first is to simply click 
the Password Protection checkbox when the ZSP Protection Status is Enabled, 
Unlocked (as shown above). The second method is to click the Change Password 
button which opens the Enter Password window. 

 

Instead of typing a new ZSP password, just click the OK button, or press the Enter key 
to store a NULL password in ZSP non-volatile memory. This has the effect of disabling 
ZSP password protection. 

Note: When ZSP password protection is disabled, the Program Counter (PC) is 
also automatically disabled. 

 

How to Enable the Program Counter 
After ZSP password protection has been enabled (as described in How to Enable ZSP 
Password Protection) the configuration window in the Advanced view displays the 
Enable Program Counter (PC) checkbox in an unchecked state. 

 

Click the Enable Program Counter (PC) checkbox to enable the use of the program 
counter and cause the PC to ZSP and PC from ZSP values to be displayed. 
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When the ZSP project file is first created, and the program counter is first enabled, the 
PC to ZSP value defaults to 0 and is stored in the ZSP Configuration and Image area. 
Otherwise the value in the PC to ZSP textbox shows the PC to ZSP value when the 
ZSP project was last saved. The PC from ZSP value was the value of the ZSP program 
counter at the time the PC was last disabled. In instances where the PC is being 
enabled on a ZSP device with a cleared Configuration and Image area, the PC to ZSP 
value will be 0. 

Please Note: If a programming operation is initiated while the Enable Program 
Counter (PC) checkbox is checked and the PC from ZSP value is 0, then the 
programming operation will fail. In this instance error code -21 is displayed on the ZSP 
LCD and the buzzer sounds the fail tone indicating that the maximum programming 
count has been reached 

To configure a new/ initial PC value click in the PC to ZSP textbox and enter the desired 
maximum number of target devices that the ZSP can program using the current project 
settings. Then click the Apply button to store the new PC value in the ZSP 
Configuration and Image Area. The ZSP Configuration Software will then read back the 
PC value from ZSP non-volatile memory and update the value displayed in the PC to 
ZSP textbox as shown below. 

 

Please Note: The ZSP password protection and the program counter are independent 
of the current ZSP project settings and target image file. The user can change the target 
image file and click the Download CFG button to update the ZSP configuration 
information; but the current ZSP password state and password value (as well as the 
ZSP lock state) will remain the same. The ZSP protection state and PC configuration  
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will also be maintained even if the user switches to a different ZSP project file (even 
when switching between S3 and Z8 Encore! devices).  

How to Change the Program Counter 
The current value of the ZSP program counter (PC) can only be changed if ZSP 
password protection is enabled, the ZSP is in an unlocked state, and the use of the 
program counter has been enabled. In this instance, the configuration window in the 
Advanced view will look similar to the following: 

 

In this example, the initial PC value that the user specified when password protection 
and the Program Counter were enabled was 500. Since that time, two programming 
operations were successfully performed and therefore the PC from ZSP textbox 
contains the value 498. 

To modify the ZSP program counter, click in the PC to ZSP textbox and enter the new 
value. It doesn't matter if the new PC value is smaller than, larger than, or equal to the 
displayed PC to ZSP or PC from ZSP values. After typing the new PC value, click the 
Apply button to store the new PC value in the ZSP Configuration and Image Area. The 
ZSP Configuration Software will then read back the PC value from ZSP non-volatile 
memory and update the value displayed in the PC to ZSP textbox as shown below. 
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How to Disable the Program Counter 
The ZSP program counter (PC) can only be disabled if ZSP password protection is 
enabled, the ZSP is in an unlocked state, and the use of the program counter has been 
enabled. In this instance, the configuration window in the Advanced view will look 
similar to the following: 

 

In this example, the initial PC value that the user specified when password protection 
and the Program Counter were enabled was 500. Since that time, two programming 
operations were successfully performed and therefore the PC from ZSP textbox 
contains the value 498. 

To disable the ZSP program counter, click in the Enable Program Counter (PC) 
checkbox. This will disable the use of the ZSP program counter and the Advanced view 
configuration window will look similar to the following image: 
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Zilog Standalone Programmer User Manual 
Refer to Zilog Standalone Programmer User Manual, UM0287. 
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Customer Support 
To share comments, get your technical questions answered, or report issues 
you may be experiencing with our products, please visit Zilog’s Technical 
Support. 
 
To learn more about this product, find additional documentation, or to 
discover other facets about Zilog product offerings, please visit the Zilog 
Knowledge Base. 

This publication is subject to replacement by a later edition. To determine 
whether a later edition exists, please visit the Zilog website at 
http://www.zilog.com 

https://www.zilog.com/index.php?option=com_product&task=tech_support&Itemid=88�
https://www.zilog.com/index.php?option=com_product&task=tech_support&Itemid=88�
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